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Developing Advanced Web Parts for SharePoint 2010 with Visual 
Studio 2010 

Estimated time to complete this lab: 30 minutes 

Lab Objective    

Web Parts are one of the core ASP.NET technologies used by SharePoint to present dynamic 
information to users.  They are the most common customization created for SharePoint.  A Web Part is 
a reusable component which exists on a Web Part Page and can present any type of web-based 
information.   
 
The objective of this lab is to learn about some of the more advanced Web Part functionality specific to 
the SharePoint system. 
 

 Create a basic SharePoint Web Part which us SharePoint Controls to display information from 

within the SharePoint site. 

 Create and customize an XsltListViewWebPart in SharePoint Designer 2010. 

 
Additional Resources 

This lab includes the following additional resources:  
 

This Lab Manual HOL3_Manual_CS.docx This document 

Source Code Completed\CS\Ex1 Completed lab source code. 

Resources Resources\CS Various resources used throughout this lab. 

 
Note: This hands on lab is currently only available as a word document download that you can review 
as a walithrough. We plan to make it available for hands on access soon. References in this lab manual 
to SPCHOL301 are also referring to this hands on lab. 
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Getting Started 

Locations 

This Hands-On Lab contains a number of additional resources in fixed locations.  By default, it is 
assumed that the base HOL directory is Supporting Files\HOL3\Resources.   
 
The default working folder for this lab is  C:\SPHOLS\HOL3. 

Lab Pre-requisites 

Browse to base HOL directory Supporting Files\HOL3\Resources and execute the optimize.ps1 
PowerShell script: 
 
1. Right click on optimize.ps1 and select Run with PowerShell: 

 

Figure 1 - Execute the PowerShell script 

2. This will open a PowerShell window to execute the script. Please wait until the PowerShell script 
completes executing the script and closes the PowerShell window: 

 

Figure 2 - PowerShell Window executing the script 
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Copying code samples from Word document 

Copying and pasting code from this Word document to Visual Studio is only safe for the sections of 
formatted code, e.g.: 
 

 

Console .WriteLine( "This is safe code!" );  

 

 
Code not in these sections may contain Unicode or other invisible characters that are not valid XML or 
C#/VB code, e.g.:   
 

Console.WriteLine(ñThis is NOT safe code !!ò);  

Code Snippets 

You can also use Code Snippets to insert the appropriate code in the lab.  
 
To use the required code snippet for this lab: 

 Right click on the code file where you want to insert the code snippet. 

 Select Insert Snippet: 
 

 
Figure 3 - Visual Studio Code Context Menu. 

 Select code snippets from My Code Snippets gallery. 

Logging in to the Virtual Machine 

Please log into the virtual machine as the following user: 
 
Username: Administrator 
Password: pass@word1 
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Exercise 1 ï Build a Visual Web Part using SharePoint controls 

Exercise Duration: 15 minutes 
 
Exercise Overview  
This example illustrates how to create a Visual Web Part and use SharePoint controls in Visual Studio 
2010. 

Task 1 ï Create a SharePoint project of type Visual Web Part 

In this task a project you will create a Visual Web Part solution and use SharePoint user controls.   
 
1. In Visual Studio 2010 and from the menu select File | New | New Project.  

2. Select the Visual C# | SharePoint | 2010 | Visual Web Part project template.  

3. Enter ProjectsListWebPart in the Name textbox. 

4. Enter C:\SPHOLS\HOL3\CS\Ex1 in the Location textbox. 
 

  

Figure 4 - New Project Dialog  

5. Press OK to create the project. 

6. A SharePoint Customization Wizard dialog box will appear. 

7. In the “What local site do you want to use for debugging?” box, type http://intranet.contoso.com 

8. For the “What is the trust level for this SharePoint solution?” radio buttons, choose “Deploy as full-
trust solution”. 

http://intranet.contoso.com/
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Figure 5 - SharePoint Customization Wizard dialog 

9. Press Finish to complete the customization wizard.  

10. Visual Studio will add the necessary files. 

Task 2 ï Create a Projects Listing Web Part 

1. In the Solution Explorer, double click on VisualWebPart1.webpart. 

2. Change the Title property in the VisualWebPart1.webpart file to Projects List Web Part. 
 

 

Figure 6 - VisualWebPart1.webpart after title change 

3. Add the following code to the end of VisualWebPart1UserControl.ascx. This code adds a 
ListViewByQyery SharePoint control, a Label asp control and a DateTime SharePoint control. 
The same can be achieved by dragging the control from the Toolbox onto the 
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VisualWebPart1UserControl.ascx files canvas. You’ll have to make sure the IDôs match the ones 
in the code below. 

 

<SharePoint : ListViewByQuery  runat ="server"  ID ="ProjectsListView" />  

<br  />  

<asp : Label  ID ="Label1"  runat ="server"  Text ="Items due by:" />  

<SharePoint : DateTimeControl  ID ="DueDate"  AutoPostBack ="true"  

OnDateChanged ="OnDate_Changed"  

    DateOnly ="true"  runat ="server">  

</ SharePoint : DateTimeControl > 

 

Code Snippet: My HTML Snippets | HOL3_ex1_usercontrol 

 

4. In the Solution Explorer, right click on VisualWebPart1UserControl.ascx and select View Code.  

5. Add the following using statements. 
 

 

using  Microsoft.SharePoint;  

using  Microsoft.SharePoint.Utilities;  

using  System.Web;  

 

Code snippet: My Code Snippets | HOL3_ex1_namespaces 

6. Add the following code to the body of the Page_Load method.  
 

 

DateTime  dueDate = DateTime .Now;  

 

if  (! string .IsNullOrEmpty(Request.QueryString[ "date" ]))  

{  

    dueDate = DateTime .Parse(Request.QueryString[ "date" ]);  

}  

DueDate.SelectedDate = dueDate;  

 

SPWeb home = SPContext .Current.Web;  

ProjectsListView.List = home.Lists[ "Projects" ];  

 

SPQuery  query = new SPQuery (ProjectsListView.List.DefaultView);  

query.ViewFields = "<FieldRef Name= \ "Title \ " /><FieldRef Name= \ "Due_x0020_Date \ " 

/>" ;  

query.Query = string .Format(  

    "<Where><Leq><FieldRef Name= \ "Due_x0020_Date \ "  /><Value 

Type= \ "DateTime \ ">{0}</Value></Leq></Where>"  

    , dueDate.ToString( "s" ));  

 

ProjectsListView.DisableFilter = true ;  

ProjectsListView.DisableSort = true ;  

ProjectsListView.Query = query;  

 

Code snippet: My Code Snippets | HOL3_ex1_pageload 
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7. Add the following code after the Page_Load method.  
 

 

protected  void  OnDate_Changed(object  sender, EventArgs  e)  
{  
    SPUtility .Redirect( SPContext .Current.ListItem.Name  
         , SPRedirectFlags .Default  
         , HttpContext .Current  
         , string .Format( "date={0}" , DueDate.SelectedDate.ToString( "d" )));  
}  
 

Code snippet: My Code Snippets | HOL3_ex1_ondatechanged 

Task 3 ï Deploy and Test 

1. You are now ready to deploy the Web Part. Right click on the Project in Solution Explorer. Select 
Deploy.   

2. If you view the Output window you can see that the deployment succeeded. 
 

 

Figure 7 - Build Output window 

3. Open a web browser to http://intranet.contoso.com. You are now going to add the Web Part to 
the home page. 

 
4. Click the Edit tab in the ribbon. Then click on Edit. 
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Figure 8 - Edit ribbon on the landing page 

5. Place the cursor in one of the Rich text editor with blue borders. In the Ribbon under Editing 
Tools, click on the Insert tab, and select Web Part. 

 

Figure 9 - Insert tab on the edit ribbon  

6. Under Categories select Custom. Projects List Web Part should appear in the list of Web Parts. 
Select Add on the right hand side. 

 

Figure 10 - Webpart insert form 

7. Click back to the Edit tab in the Ribbon, and click on the red box to Stop Editing. 
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Figure 11 - Edit ribbon highligting the Stop Editing button 

8. You now have your new Web Part listing projects on the home page. 

 

 

In the past few minutes you have demonstrated building a Visual Web Part with SharePoint controls.  
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Exercise 2 ï XSLT List View Web Part 

The Xslt List View Web Part is a new web part in WSS v4. This web part is used in place of the Data 
View Web Part in Windows SharePoint Services v3.0 (The Data View Web Part is still available in 
SharePoint Foundation v4.0). The Xslt List View Web Part is very easy to create in SharePoint 
Designer 2010. 
 
For this exercise you will create an Xslt List View Web Part within SharePoint Designer 2010 that will 
show a list of employees on the Home Page of the Contoso Intranet. The list of employees will be 
pulled from  the Employees list that exists within the Contoso site. The web part will be created 
completely in SharePoint Designer 2010. This will give us an understanding of the markup created by 
the Xslt List View Web Part. 

Task 1 ï Open SharePoint Designer 

1. Open SharePoint Designer 2010. 

2. Open Site http://intranet.contoso.com. 

 

Figure 12 - SharePoint Designer 2010 Site menu 

3. In the Open Site dialog window enter http://intranet.contoso.com in the Site Name. 

http://intranet.contoso.com/
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Figure 13 - Open Site dialog window 

4. If prompted for authentication, enter the following details: 

Username: administrator 

Password: pass@word1  

5. From the SharePoint Site left navigation select Site Pages, then Home.aspx. 

 

Figure 14 - Site Pages - Home Page 

6.  From the Ribbon menu, select Edit Page In Advanced Mode. 
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Figure 15 - Edit Page in Advanced Mode button in the ribbon 

Task 2 ï Add Xslt List View Web Part 

7. In the Code view, scroll down to the bottom of the page click into the first div in the Bottom web 
part zone. 

 

Figure 16 - Selecting the first div in the Bottom web part zone 

8. Select the Insert tab in the ribbon. 

9. Click on the Data View item dropdown. 

 

Figure 17 - Data View button in the ribbon 

10. Select the Employees list. 

11. SharePoint designer will add the new XsltListViewWebPart to the HomePage.aspx. 

12. Click the Save icon at the top of the page. 

 

Figure 18 - Save button highlighted in the ribbon 

13. If prompted for confirmation, click Yes. 

14. Open a web browser to http://intranet.contoso.com.  

http://intranet.contoso.com/
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15. Ignore any warnings, if any. 

16. You should now see the new XsltListViewWebPart.  

Task 3 ï Modify Xslt List View Web Part 

1. Return to SharePoint Designer 2010. You are now going to make some modifications to the 
XsltListViewWebPart.  

2. The Fullname column of the Employees list needs to stand out.  

3. In the Designer View, select the table cell containing the word Fullname.  

 

Figure 19 - Fullname Table Cell 

4. Using the Apply Styles window on the bottom right. Scroll down to the in the Select CSS style to 
apply: to .ms-bodyarepagemargin. Right click Apply Style. 

 

Figure 20 - Apply Style 

5. In the code view of the Designer scroll up to RowLimit and change the value 100 to 5.  
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Figure 21 - Change Row Limit 

6. In the code view of the Designer scroll up to WebPartPages:XsltListViewWebPart and add the 
ChromeType property and choose TitleAndBorder as the chrome type 

 

 

Figure 22 - Add ChromeType Property 

7. Click the Save icon at the top of the page. 

 

Figure 23 - Save button highlighted in the ribbon 

Task 4 ï Deploy and Test 

1. Open a web browser to http://intranet.contoso.com. You should now see the modified 
XSLTListViewWebPart listing only 5 employees per page.  
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Figure 24 - Modified XSLTListViewWebPart 
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Lab Summary 

In this lab you performed the following exercises. 

 Created a Visual Web Part using Visual Studio 2010. 

 Used a SharePoint Control from the toolbox. 

 Used the SharePoint ListViewByQuery control. 

 Used the inbuilt deployment within Visual Studio 2010 to deploy the SharePoint Visual Web Part 

project. 

 Used SharePoint Designer to create an XsltListViewWebPart. 

 Customized the XsltListViewWebPart. 

 Manipulated a SharePoint Web Site to host a Web Part. 

 

In this lab, you learned how to create a SharePoint Visual Web Part from scratch. You learned how to 

use controls from both the Toolbox as well as SharePoint controls such as the ListViewByQuery and 

deployed the Web Part solution. Actions were also performed upon the SharePoint Web interface 

where you added a Web Part to an existing page and modified that Web Part accordingly. You also 

used the XsltListViewWebPart, and customized it using SharePoint Designer.  


